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ABSTRACT 
This document provides step-by-step guidance on how to configure a Microsoft® Windows Server® 2008 

Hyper-V™ solution on NetApp® storage. 
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1  INTRODUCTION 

This document provides step-by-step guidance on how to configure a Microsoft® Windows Server® 2008 

Hyper-V™ solution on NetApp® storage. It documents in detail the configuration steps for an environment 

with two Windows Server 2008 Hyper-V systems with full installation, two Windows Server 2008 Hyper-V 

systems with server core installation, one Windows Server 2008 full installation system with System Center 

Virtual Machine Manager 2008 (SCVMM) installed, and one NetApp FAS3070C storage array configured 

with both FC and iSCSI protocols. The information in this guide assists in setting up a proof of concept 

(POC) environment or even a production environment. This guide is intended for storage and systems 

administrators who are familiar with Microsoft Hyper-V and NetApp storage.  

Note: The scope of this document is limited to deployment instructions only; it should not be considered as a 

design guide. For detailed information about NetApp best practices for Hyper-V, see NetApp TR-3702 and 

TR-3701.  

Proper licensing for the NetApp controllers, NetApp storage management software installed on the Windows 

Server 2008 Hyper-V servers, Microsoft Windows Server 2008, and any OS installed on the virtual machines 

must be obtained to use the features described in this guide. Where appropriate, trial licenses can be used 

for many of the components in order to test the configuration.  

Figure 1 shows the configuration process that is outlined in this document. 

Figure 1) Steps for setting up Hyper-V on NetApp storage. 

 

 

 

 

 

 

http://www.microsoft.com/windowsserver2008/en/us/hyperv.aspx
http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/default.aspx
http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/default.aspx
http://www.microsoft.com/systemcenter/virtualmachinemanager/en/us/default.aspx
http://www.netapp.com/us/library/technical-reports/tr-3702.html
http://www.netapp.com/us/library/technical-reports/tr-3701.html
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2 SOLUTION ARCHITECTURE 

Figure 2 shows the high-level architecture of the environment setup to demonstrate the deployment of 

Microsoft Hyper-V on NetApp storage. 

 Figure 2) Physical architecture. 

3 SOLUTION CONFIGURATION 

3.1 NETAPP STORAGE SYSTEM CONFIGURATION  

It is important to follow the recommendations and requirements described in this document for a successful 

deployment of the environment shown in Figure 2. 

3.1.1 NetApp Storage System Hardware and Software Requirements 

The components, quantity, and details shown in Table 1 describe the requirements for configuring 

NetApp storage systems. It is important to install the required hardware and software components 

to support the planned environment shown in Figure 2.  
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Table 1) NetApp storage system hardware and software requirements.  

NetApp System Component Quantity Details 

Number and Type of Controllers 1 FAS3070c 

1GB Ethernet NICs 2-4 Min. two per controller (on board) 

Fibre Channel Ports 2-4 Min. two per controller (on board) 

Data ONTAP®  n/a Version 7.3 or later 

FAS Controller CF Mode n/a Single Image 
 

3.1.2 NetApp Software Requirements 

The NetApp software components described in Table 2 are meant to be installed on the Windows 

Server 2008 Hyper-V servers planned as part of the environment shown in Figure 2.  

Table 2) NetApp software requirements. 

NetApp Software Component Quantity Details 

NetApp Windows® Host Utilities Kit 4 
5.x (one per Microsoft Windows Server 
2008 server) 

NetApp Data ONTAP DSM for Windows 
MPIO 

4 
3.2r1 (one per Microsoft Windows 
Server 2008 server) 

NetApp SnapDrive® for Windows 2 
6.x (one per Microsoft Windows Server 
2008 server with full installation) 

 

3.1.3 NetApp License Requirements 

The NetApp license components described in Table 3 are meant to be installed on both the NetApp 

storage system and the Microsoft Windows Server 2008 servers planned as part of the 

environment shown in Figure 2. It is important to pay attention to the details column to determine 

which license components should be installed on the NetApp storage system and which on the 

Microsoft Windows Server 2008 servers. 

Table 3) NetApp license requirements. 

NetApp License Component Quantity Details 

FCP 2 One per controller 

iSCSI 2 One per controller 

Cluster 1  

NetApp SnapDrive for Windows 2 
One per Microsoft Windows Server 
2008 server with full installation 

NetApp SnapRestore® 2 One per controller 

NetApp Windows Host Utilities Kit 4 
One per Microsoft Windows Server 
2008 server 

NetApp Data ONTAP DSM for Windows 
MPIO 

4 
One per Microsoft Windows Server 
2008 server 
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3.2 NETWORKING CONFIGURATION 

3.2.1 IP Network Configuration 

For a redundant, highly available IP storage network, configure virtual interfaces (VIF) on both of 

the NetApp storage controllers, using the procedure outlined in this section. If this is an existing 

storage array that already has the VIFs configured, this procedure may not be necessary.  

For this exercise, we used one Ethernet switch. In your environment, you may have multiple 

switches. Figure 3 shows the connectivity. 

Figure 3) NetApp storage controller VIF configuration. 
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To create a virtual interface on NetApp storage controllers, follow these steps. 

Step Action 

1. Log in to the FilerView® GUI and select Network > Add Virtual Interface. 

2. Enter the VIF name and select the network interfaces that will be part of the VIF. Select 
Multiple from the Trunk Mode drop-down list and select IP from the Load Balancing drop-
down list. Click Apply. 

 

3. Click Up to bring the virtual interface online. 
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To edit the RC file, follow these steps.  

Step Action 

1. Edit the RC file in the /etc directory of each NetApp storage controller‟s root 

volume. 

Note: If using Windows to edit RC file, use WordPad instead of Notepad when asked 

what program to open the RC file with. 

2. Edit the RC file on both of the storage controllers by adding the following lines just before 
the savecore entry.  

For this exercise, we will use the 192.168.89.0/24 network for iSCSI connectivity:  

vif create multi vif0 -b ip e0c e0d 

ifconfig vif0 192.168.89.10 netmask 255.255.255.0 partner vif0 

up 

3. To reread the configuration from the RC file, log in to each storage controller console and 
enter the following command: 

source /etc/rc 
 

3.2.2 Fibre Channel Network Configuration 

This procedure is required only if you plan to test Hyper-V over Fibre Channel. Otherwise,  skip to 

section 3.3. 

For a redundant, highly available FC storage network, perform FC connectivity on both of the 

NetApp storage controllers as shown in Figure 4. If this is an existing storage array that already has 

the Fibre Channel network configured, this procedure may not be required. Also, Single Image is 

the recommended CF mode. 

For this exercise, we will use two FC switches; each NetApp controller has one FC connection to 

each switch. Figure 4 shows the connectivity. 
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Figure 4) NetApp storage controller target ports configuration. 

3.3 MICROSOFT HYPER-V AND SCVMM CONFIGURATION  

3.3.1 Windows Server 2008 Full Installation 

3.3.1.1 System Requirements 

For detailed information on system requirements, refer to the Microsoft documentation. 

Software Requirements 

Software Components 
Quantity and/or 

Type 

Windows Server 2008 x64 Enterprise or Windows Server 2008 
x64 Datacenter Edition (Windows Server 2008 Standard Edition 
does not support Windows Failover Clustering) 

2 

License keys for OS to be installed on Hyper-V child VMs 2 

The system should be able to use a name-resolution service, such 
as Domain Name System (DNS), DNS dynamic update protocol, 
Windows Internet Name Service (WINS), or Hosts file. 

N/A 

Active Directory Domain N/A 

http://www.microsoft.com/windowsserver2008/en/us/system-requirements.aspx
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Hardware Requirements  

Hardware Components 
Quantity and/or 

Type 

64-bit servers with support for hardware-assisted virtualization 
technology, such as Intel® Virtualization Technology (Intel VT) or 
AMD Virtualization (AMD-V), identical hardware, and the same 
processor architecture 

2 

Minimum CPU speed 1.0GHz 

Processor Intel VT or AMD-V 

Minimum RAM 512MB (additional 
memory needed for 

each child OS) 

Network Requirements 

Network Components 
Quantity and/or 

Type 

Network adapters per server 4 

 

3.3.1.2 Install Microsoft Windows Server 2008  

For detailed information on the installation and configuration of Windows Server 2008, 

refer to the Microsoft documentation. 

 Follow the instructions carefully and be sure to apply the Hyper-V update 

packages for Windows Server 2008 (KB950050) on the parent partition of the full 

installation. 

 Install all Microsoft packages required for Hyper-V according to the instructions in 

the Microsoft documentation.  

3.3.1.3 Network Configuration 

CONFIGURE MANAGEMENT INTERFACE 

Configure one network adapter on the Windows Server 2008 server or servers to be used 

for the management network; give it an easily readable name (for example, LLAN01); and 

assign a static public IP address.  

CONFIGURE IP STORAGE INTERFACES 

This procedure is required only if configuring NetApp shared storage over iSCSI. 

Configure two network adapters on the server or servers to be used for configuring and 

managing iSCSI storage traffic over MS iSCSI Software Initiator and NetApp SnapDrive 

software. The two network connections are recommended for high availability. Assign 

them easily readable names (for example, SLAN01 and SLAN02) and static public or 

private IP addresses. Make sure that the NetApp storage network port or virtual interface 

(for iSCSI storage) can be reached from the servers.  

3.3.1.4 Install Hyper-V Role 

To install the Hyper-V Role, follow these steps. For more information on installing Hyper-V 

role, refer to the Microsoft documentation. 

http://download.microsoft.com/download/e/6/3/e63cf2f6-7f71-450b-8e4a-dace88e99456/readme.htm
http://technet.microsoft.com/en-us/library/cc732470.aspx
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Step Action 

1. Open Server Manager: Start > Programs > Administrative Tools > Server 
Manager. 

2. Right-click Roles in the left pane. 

3. Select Add Roles from the context menu. 

 

4. Select Hyper-V from the list of server roles and click Next. 

 

5. Review the information associated with the Introduction to Hyper-V and click 
Next. 



12    Hyper-V on NetApp Deployment Guide 

6. You can select Ethernet cards for virtual networks at this time, or you can 
choose to configure the virtual networks after the configuration of Hyper-V.   

For this exercise, we will perform this step later. Click Next to continue.   

 

7. Review the confirmation information and click Install. 

8. The computer must be restarted to complete the installation. Click Close to 
finish the wizard and then click Yes to restart the computer. 

 

9. Upon restart, log in with the same account used to install the Hyper-V role.  
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10. When the Resume Configuration wizard completes the installation, click Close.  

 

 

3.3.1.5 Virtual Network Configuration 

Create Hyper-V Virtual Networks by using the procedure outlined in the following Microsoft 

documentation: 

 http://technet.microsoft.com/en-us/library/cc816585.aspx 

 http://technet.microsoft.com/en-us/library/cc732470.aspx#BKMK_ConfigVN 

For this exercise, we created public networks for VM LAN traffic and SAN traffic (for 

configuring the iSCSI software initiator on the child VM). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://technet.microsoft.com/en-us/library/cc816585.aspx
http://technet.microsoft.com/en-us/library/cc732470.aspx%23BKMK_ConfigVN
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Step Action 

1. Open Hyper-V Manager: Start > Programs > Administrative Tools > Hyper-V 
Manager. 

2. From the Actions menu on the right, select Virtual Network Manager. 

3. Below ”Create virtual network”, select the type of network to create. The types of 
network are External, Internal, and Private.  

For this exercise we will create one external network for virtual machine LAN 
traffic. The same procedure applies to creating an external network for SAN 
traffic. In all, we will create two external networks for LAN and two external 
networks for SAN. 

 

4. In the Virtual Network Manager window, click Add to open the New Virtual 
Network page. 
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5. Enter a name for the new network and specify the external physical adapter to 
bind to this virtual network. Review the other properties and modify them if 
necessary. Click OK to create the virtual network and close Virtual Network 
Manager; or click Apply to create the virtual network and continue using Virtual 
Network Manager. (This virtual network will later bind to the new virtual machine 
that will be created by using the Hyper-V Manager.) 

 

3.3.2 Windows Server 2008 Server Core Installation 

This procedure is required only if you plan to install Windows Server 2008 with the server core 

installation option. Otherwise, skip to section 3.3.3.  

The server core installation option of the Windows Server 2008 operating system installs a minimal 

server installation of Windows Server 2008 to run supported server roles, including the Hyper-V 

role.  

3.3.2.1 System Requirements 

For detailed information on system requirements, refer to the Microsoft documentation. 

Software Requirements   

Software Components 
Quantity and/or 
Type 

64-bit Windows Server 2008 Enterprise or Windows Server 2008 
Datacenter Edition 

2 

License keys for OS to be installed on Hyper-V child VMs 2 

The system should be able to use a name-resolution service, such 
as Domain Name System (DNS), DNS dynamic update protocol, 
Windows Internet Name Service (WINS), or Hosts file  

N/A 

http://www.microsoft.com/windowsserver2008/en/us/system-requirements.aspx
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Active Directory Domain N/A 

  Hardware Requirements  

Hardware Components 
Quantity and/or 

Type 

64-bit servers with support for hardware-assisted virtualization 
technology, such as Intel Virtualization Technology (Intel VT) or 
AMD Virtualization (AMD-V), identical hardware, and the same 
processor architecture 

2 

Minimum CPU speed 1.0GHz 

Processor Intel VT or AMD-V 

Minimum RAM 512MB (additional 
memory needed for 

each child OS) 

  Network Requirements 

Network Components 
Quantity and/or 

Type 

Network adapters per server 2 (minimum) 

3.3.2.2 Install Microsoft Windows Server 2008  

For detailed information on the installation and configuration of Windows Server 2008 

server core installation, refer to the Microsoft documentation. 

Be sure to follow the instructions in setting up the following: 

 Setting the administrative password 

 Setting a static IP address 

 Joining a domain 

 Renaming the server (optional) 

 Activating the server 

 Configuring the firewall for remote administration and enabling Remote Desktop 

Protocol (RDP) access 

 Applying the Hyper-V update packages for Windows Server 2008 (KB950050) on 

the parent partition of the Server Core installation 

 Installing any other Microsoft packages required for Windows Server 2008 with 

server core installation, according to  the Microsoft documentation  

 

 

 

 

 

 

http://download.microsoft.com/download/b/1/0/b106fc39-936c-4857-a6ea-3fb9d1f37063/Server_Core_Installation_Option_of_Windows_Server_2008_Step-By-Step_Guide.doc
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Step Action 

1. Enable remote management of the servers by using the Computer Management 
Microsoft Management Console (MMC) snap-in. 

netsh advfirewall firewall set rule group="Remote 

Administration" new enable=yes 

 

This opens up the rules to allow Remote Management and unlock the following 
MMC snap-ins: 

 Task Scheduler (taskschd.msc)  

 Event Viewer (eventvwr.msc)  

 Shared Folders (fsmgmt.msc)  

 Performance Monitor (perfmon.msc)  

Device Manager (devmgmt.msc) 

CONFIGURE THE VIRTUAL DISK SERVICE (VDS) 

By default, the Virtual Disk Service is set to start manually on server core installations of 

Windows Server 2008. The service should be set to start automatically and after that it 

should be started manually. This enables you to use the MMC Disk Management snap-in 

to remotely access a server core installation. 

Step Action 

1. Enter the following command on both of the servers: 

sc config vds start=auto 

2. Start the VDS Service: 

net start vds 

ENABLE EXCEPTIONS IN THE FIREWALLS 

Remote disk management exception also needs to be enabled on the server core 

installation server and the server that is used to manage the server core installation 

server.  

Step Action 

1. Enter the following command on both of the servers: 

netsh advfirewall firewall set rule group="Remote Volume 

Management" new enable=yes  

 

Now the server core can be managed by using the Disk Management portion of 
the Computer Management MMC snap-in. 

3.3.2.3 Install the Hyper-V Role 

Follow the instructions in the Microsoft documentation to enable the Hyper-V Role.  

 

 

 

 

 

 

http://www.microsoft.com/downloads/details.aspx?FamilyID=5da4058e-72cc-4b8d-bbb1-5e16a136ef42&displaylang=en
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Step Action 

1. Enter the following command on both of the servers: 

start /w ocsetup Microsoft-Hyper-V 

  

3.3.2.4 Network Configuration 

CONFIGURE MANAGEMENT INTERFACE 

If it was not done earlier when installing the Windows Server 2008 server core option, 

configure one network adapter on the Windows Server 2008 server or servers to be used 

for the management network and assign a static public IP address. 

Step Action 

1. Enter the following command on both of the servers: 

netsh interface ipv4 set address name="<ID>" 

source=static address=<StaticIP> mask=<SubnetMask> 

gateway=<DefaultGateway> 

CONFIGURE IP STORAGE INTERFACES 

This procedure is required only if configuring NetApp shared storage over iSCSI. 

Configure two network adapters on the Windows Server 2008 server or servers to be used 

for configuring and managing iSCSI storage traffic over MS iSCSI Software Initiator and 

NetApp SnapDrive® software. Assign static IP addresses to the two network adapters. 

The two network connections are recommended for high availability. Make sure that the 

NetApp IP storage network port or virtual interface can be pinged from the servers. 

Step Action 

1. Enter the following command on both of the servers: 

netsh interface ipv4 set address name="<ID>" 

source=static address=<StaticIP> mask=<SubnetMask> 

gateway=<DefaultGateway>  

3.3.2.5 Virtual Network Configuration 

The Windows Server 2008 server core installation does not have the Hyper-V Manager 

GUI, but you can remotely manage the server by using the Hyper-V Manager on the 

Windows Server 2008 full installation server. 
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Create virtual networks for VM LAN and SAN traffic (if configuring LUNs by using the 

iSCSI software initiator inside the child VM) by using the procedure described in section 

3.3.1.5.  

3.3.3 SCVMM 2008 Installation  

For the detailed procedure for installing and configuring SCVMM, refer to the Microsoft 
documentation. For this exercise, we will install SCVMM on a Windows Server 2008 full installation 
system. 

3.3.3.1 SCVMM Server Components  

The first procedure in installing SCVMM is to install the server components. Follow these 

steps. 

Step Action 

1. Select Server from the installation splash screen.  

2. Accept the license terms.  

3.  Select an option for updating SCVMM: Microsoft Update or manual methods. 

4. Select whether to participate in the Microsoft Customer Improvement Program. 

5. Enter your name and the name of your organization. 

6. If you have completed the prerequisites check, click Next to continue the 
installation.  

7. Select an installation path for the SCVMM server components. 

8. Select the appropriate SQL Server® settings. If you choose to configure 
SCVMM with a previously installed SQL Server instance, follow the Microsoft 
recommendations: http://technet.microsoft.com/en-
us/library/bb740749(TechNet.10).aspx. 

9. a. Select a share name for the SCVMM library; if possible, choose a share name 
that is short and easy to recall.  

b. Select a share location. Select the LUN that you configured for the SCVMM 
library, then select Create New Folder on the LUN and select the newly created 
folder. If possible, select a short folder name for the SCVMM library, usually 
matching the share name.   

c. Enter a share description.  

10. Unless you have good reason to change the default port settings for the 
SCVMM installation, do not change them. If you do make changes, be sure to 
record the newly configured port numbers and their respective settings. 

11. Review the summary of settings, then select Install to begin installation of 
SCVMM and its required components. 

http://technet.microsoft.com/en-us/library/cc917964.aspx
http://technet.microsoft.com/en-us/library/bb740749(TechNet.10).aspx
http://technet.microsoft.com/en-us/library/bb740749(TechNet.10).aspx
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12. Depending on the components required by SCVMM, which may or may not 
already be installed on the server, you may be asked to answer requests to run 
or install components using pop-ups outside the installation. These are 
generated by the SCVMM installation.  Click Run to continue installing SCVMM. 

13. When the installation is complete, review the summary information and click 
Close to finish installing the SCVMM.  

 

3.3.3.2 SCVMM Administrator Console 

The second procedure is to install the SCVMM Administrator Console components, either 

on the server on which you just installed the server components or on another supported 

server or workstation.  

To install the Administrator Console, follow these steps. 

Step Action 

1. Select Administrator Console from the installation splash screen.  

2. Accept the license terms.  

3.  Select an option for updating SCVMM: Microsoft Update or manual methods. 

4. Acknowledge information associated with the Microsoft Customer Improvement 
Program. 

5. If you have completed the prerequisites check, click Next to continue the 
installation.  

6. Select an installation path for the SCVMM server components. 

7. Enter the port number configured during the previous installation of the SCVMM 
server components.  

8. Review the summary of settings before continuing, then click Install to begin 
installing SCVMM and its required components. 

9. Depending on the components required by SCVMM, which may or may not 
already be installed on the server, you may be asked to answer requests to run 
or install components using pop-ups outside the installation. These are 
generated by the SCVMM installation. Click Run to continue installing SCVMM.  

10. After the installation is complete, review the summary information and click 
Close to finish installing the SCVMM.  

3.4 INSTALL NETAPP SOFTWARE ON WINDOWS SERVER 2008  

3.4.1 Windows Server 2008 Full Install 

3.4.1.1 NetApp Windows Host Utilities Kit 

To install Windows Host Utilities 5.x on the servers, follow these steps.  
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Step Action 

1. Log in to NOW™ (NetApp on the Web), (http://now.netapp.com). Under 
Software Download, click Download Software. 

2. On the download software page, select Windows in either the FCP Host Utilities 
entry or the iSCSI Host Utilities entry and then click Go. Windows Host Utilities 
5.x combines two previous products, iSCSI WHU 4.1 and FCP WHU 4.0. 

 

3. Select Windows Host Utilities 5.0. 

 

http://now.netapp.com/
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4. On the Windows Host Utilities 5.0 Download Page, click 
netapp_windows_host_utilities_5.0_x64.msi to download the file. 

 

5. Double-click the downloaded file and click Run. Make sure that you are logged 
in as local administrator or domain administrator to the Windows Server 2008 
server. 

Note: If there is a Microsoft hot fix prerequisite, a warning appears and the 

installation is canceled. Download the required hot fix and retry the host utilities 
installation.  

6. On the welcome page, click Next. 

7. Accept the licensing agreement and click Next. 
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8. Select the protocol support required and click Next. 

 The base registry entries and HBA parameters are set depending on 
your choice. 

 Host utilities are installed. 

 Select the Both option to install all of the utilities. 

For this exercise, we will select Both. 

 

9. If you will have multiple paths configured to the storage array, select “Yes, install 
support for Multipath I/O” and click Next.  

For Windows Server 2008, this automatically installs and enables the Microsoft 
MPIO components feature and installs support for the Microsoft Device Specific 
Module (MSDSM). 

 

10. Specify the installation location and click Next. 



24    Hyper-V on NetApp Deployment Guide 

11. Click Next to begin the installation. 

12. Monitor the installation and click Finish when it is complete. 

13. The computer must be restarted to complete the installation. Click Yes to restart 
the computer. 

14. When the computer restarts, verify the installation: Start > Programs > NetApp > 
Windows Host Utilities. Also navigate to the installation directory to verify the 
installed files. 

3.4.1.2 NetApp Data ONTAP DSM for Windows MPIO  

To install Data ONTAP DSM for Windows MPIO on the servers, follow these steps.  

Step Action 

1. Log in to NOW (http://now.netapp.com). Under Software Download, click 
Download Software. 

2. Next to Multipath I/O, select Windows and click Go. 

 

3. On the Multipath I/O for Windows page, click View and Download. 

4. On the Data ONTAP DSM for Windows MPIO page, click Data ONTAP DSM 
3.2R1 for Windows MPIO. 

5. Read the Data ONTAP DSM 3.2R1 for Windows MPIO Description Page and 
click Continue. 

6. Read the Base Customer Software License Agreement and click Accept. 

http://now.netapp.com/
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7. On the Data ONTAP DSM 3.2R1 for Windows MPIO Download Page, click 
Install Package for Windows Server 2008 x64 (AMD and Intel) systems to 
download the file to the server. 

 

8. On the server, double-click the installation file and click Next on the welcome 
screen. 

9. Accept the license agreement and click Next. 

10. On the License Key page, enter the license key and click Next.  

11. On the Data ONTAP DSM Management Service Credentials page, enter the 
account information for a user account that is a member of the local 
administrator group of the Windows Server 2008 server and click Next. For this 
exercise, we will use a local user account, sd_admin, which is a member of the 
local administrator group for the server. 
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12. Select the protocol support required and click Next. For this project, we will 
select Both. 

 

13. Verify the driver information and click Next. 

 

14. Verify the installation folder and click Next. 

15. Click Install to begin installation. 

16. On completion, click Finish. 

17. Click Yes to restart the computer. 
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18. After restarting, verify the installation: Server Manager > Storage > Data ONTAP 
DSM Manager. 

 

3.4.1.3 NetApp SnapDrive for Windows  

DOWNLOAD 

To download NetApp SnapDrive 6.0 for Windows, follow these steps.  

Step Action 

1. Log in to NOW (http://now.netapp.com). Under Software Download, click 
Download Software. 

2. On the Download Software page, next to SnapDrive, select Windows and click 
Go. 

 

http://now.netapp.com/
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3. Click View and Download for SnapDrive 6.0. 

 

4. Read the SnapDrive 6.0 for Windows description page and click Continue. 

5. Read the Customer Software License agreement and click Accept.  
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6. On the SnapDrive 6.0 for Windows – Download page, click the installation 
package link for x64 Windows OS. 

 

7. Download and install the required Microsoft Windows hotfixes from the Microsoft 
support Web site (http://support.microsoft.com/). 

INSTALLATION  

Before installing SnapDrive 6.0 for Windows, you must establish a SnapDrive service 

account and make sure that the authentication requirements are met. To perform 

functions related to SnapDrive for Windows on either the host or a storage system, 

SnapDrive needs to be able to use a service account that has specific types of access 

established. The transport protocols that can be used are RPC, HTTP, and HTTPS. For 

configuration information about these protocols, see the SnapDrive 6.x Installation and 

Administration Guide.  

For this guide, we will assume that the storage system and servers are not part of the 

same domain and that HTTP is used as the transport protocol. 

 

 

 

 

 

 

 

 

 

http://support.microsoft.com/
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Step Action 

1. Configure User Account on the storage system. For this exercise, we will create 
a user with the same user name (sd_admin) as used in section 3.4.1.2, “NetApp 
Data ONTAP DSM for MPIO.”  

a. Log in to the NetApp storage controller CLI. 

b. Create a new role for SnapDrive and add the required API capabilities: 

useradmin role add sd_admin_r -a login-*,api-* 

c. Create a new group and assign the role created in the previous step: 

useradmin group add sd_admin_g –r sd_admin_r 

d. Create a new user and add it to the group created in the previous step: 

useradmin user add sd_admin –g sd_admin_g  

2. Create a new local user on the server with the same user name and password 
as created on the storage system in step 1. For this exercise, we will use the 
same local user account (sd_admin) that was used in section 3.4.1.2. “NetApp 
Data ONTAP DSM for MPIO.” 

3. Log in to the server as local or domain administrator and double-click the 
SnapDrive installer. 

4. Click Next at the welcome screen, accept the license agreement, and click Next. 

5. Enter the license key and click Next. 

 

6. Verify the installation location and click Next. 
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7. Enter SnapDrive Service Credentials information. This can be any domain user 
who is member of the local Administrators group on the Windows Server 2008. 

For this exercise, we have created a domain user sd_admin.   

Note: The domain user is required if the Windows Server 2008 servers will be 

configured as nodes in Windows Failover Cluster. 

 

8. Verify the default SnapDrive Web services configuration and click Next. 

9. Select HTTP as the transport protocol. There are other options available as well. 
For more information, see the SnapDrive 6.x Installation and Administration 
Guide at http://now.netapp.com. 

Specify the username and password for the HTTP protocols that will be used to 
communicate with the storage system and click Next. This username is the 
same local user created earlier in the procedure. 

  

http://now.netapp.com/
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10. (Optional) Configure Protection Manager Integration and click Next. For this 
exercise, we will leave the box unchecked. 

 

11. Click Install to continue. 

12. Click Finish to complete the installation. 

13. Verify the installation: Server Manager > Storage > SnapDrive > Storage 
System Management.  

14. Add the hostname or IP address of the NetApp storage array that will be used 
for storage. 

Storage System Management > Add storage system. 

 

 

3.4.2 Windows Server 2008 Server Core Installation 

This procedure is required only if you plan to install Windows Server 2008 with the server core 

installation option. Otherwise, skip to section 3.5.  

3.4.2.1 NetApp Windows Host Utilities Kit  

The procedure is the same as outlined in section 3.4.1.1. The only difference is that the 

host utilities msi download file must be executed from the command line by using the 

following command. The rest of the installation procedure is the same. 
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Step Action 

1. Enter the following command on both of the servers: 

msiexec /package <NetApp Windows Host Utilities>.msi 

3.4.2.2 Install Data ONTAP DSM for Windows MPIO 

The procedure for installing Data ONTAP DSM for MPIO is the same as described in 

section 3.4.1.2. The only difference is that the msi download file must be executed from 

the command line by using the following command. The rest of the installation procedure 

is the same. 

Step Action 

1. Enter the following command on both of the servers: 

msiexec /package <NetApp Data ONTAP DSM for MPIO>.msi 

3.5 FIBRE CHANNEL ZONING CONFIGURATION (OPTIONAL)  

Configure Fibre Channel zoning if you plan to use Fibre Channel for connectivity between the Hyper-V 

servers. The procedure is the same for both full and server sore installation options. For this exercise, we 

configure FC zoning for Windows Server 2008 full installation only. 

Figure 5) FC configuration. 

Obtain the WWPN for the FC HBA ports on the Windows Server 2008 server by using the NetApp Windows 

Host Utilities installed earlier in the process. This procedure is same for both Windows Server 2008 full and 

server core installation options. 

To obtain the WWPN, follow these steps. 
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Step Action 

1. On the Windows Server 2008 server, open a command line window and run the 
hba_info.exe file to obtain the WWPN for the HBA ports that are connected to the FC 

SAN switches. 
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2. Log in to the FilerView® GUI and select LUNs > FCP > Report to obtain the port name 
for the FC ports connected to the SAN switches. 

 

 

This step can also be performed from the CLI using the following steps: 

Telnet or SSH to the NetApp storage controller and obtain the WWPN for the FC ports 
that are connected to the SAN switches by running the following command: 

fcp portname show 

 

3. Using appropriate SAN management software, configure SAN zoning between the 
Windows Server 2008 server or servers and the NetApp storage array. 

3.6 NETAPP STORAGE PROVISIONING  

3.6.1 Configure an Aggregate 

The first step to configuring storage on NetApp storage is to add a new aggregate. To configure an 

aggregate by using NetApp FilerView, follow these steps. 
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Steps Action 

1. Open NetApp FilerView, click Aggregates, and click Add. 

 

2. For Aggregate Name, enter a name that includes “Hyper-V” and that reflects the Hyper-V 
environment that will use it.  

Select the Double Parity check box to take advantage of RAID-DP® (the NetApp 
recommended RAID level for an aggregate). Click Next. 
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3. For RAID Group Size, select the number of disks to assign.  

NetApp recommends that you accept the default value of 16. 

 

4. For Disk Selection, select the method for selecting disks to be used for the aggregate. 
Automatic is selected by default and is the NetApp recommended best practice. 
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5. For Disk Size, select the disk size to be used in the aggregate. Any Size is selected by 
default. NetApp recommends selecting disks of the same size when creating an 
aggregate. 

 

6. For Number of Disks, select the number of disks to be added to the aggregate. NetApp 
best practice is to create as large an aggregate as possible. Assign at least three disks to 
provision an aggregate.  

Click Next and then click Commit to finish creating the new aggregate. As recommended 
earlier, make non root aggregates as large as possible to benefit from the I/O capacity of 
all the spindles in the aggregate.  
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3.6.2 Configure Flexible Volumes 

Flexible volumes (FlexVol®) contain LUNs that are accessed by Windows Server 2008 servers 

over FC or iSCSI. These LUNs can be used as logical disk drives (called physical disks in Hyper-V 

terminology) that serve as the storage location for the virtual hard disk (VHD) files representing the 

VMs running on Windows Server 2008 server, or as a physical disk directly accessed by the VM 

(also referred to as a pass-through disk).  

For this exercise, we create flexible volumes for hosting quorum disks and for VMs provisioned via 

Hyper-V Manager on both the Windows Server 2008 full and server core installation options, and 

also SCVMM.  

Note: It is not a technical requirement to create separate flexible volumes for hosting VMs 

provisioned using different methods.  

3.6.2.1 Create a NetApp Flexible Volume for the LUN Configured As the Windows 
Failover Cluster Quorum Disk on Full Installation 

To configure a flexible volume by using NetApp FilerView, follow these steps. 

Step Action 

1. Open NetApp FilerView, click Volumes, and click Add. 

2. For Volume Type Selection, select Flexible. 
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3. Enter the volume name.  

NetApp recommends accepting the default values for Language and UTF-8, 
unless you have good reason to change these values. 
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4. For Containing Aggregate, select the aggregate on which the flexible volume 
should be created, such as the aggregate that you created in section 3.6.1, 
“Configure an Aggregate.”  

For Space Guarantee, select the appropriate option. To achieve volume-level 
thin provisioning, select None”. For this exercise, we will select Volume. 

For details on different volume configuration settings to achieve space savings, 
refer to NetApp TR 3505. 

 
 

5. For Volume Size Type, select Total Size. Enter the volume size (for example, 
10GB). For Snapshot Reserve, enter 0.  

  

http://www.netapp.com/us/library/technical-reports/tr-3505.html
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6. Click Next to verify the settings and click Commit.  

7. Disable the automatic Snapshot™ schedule for the volume: Volume > 
Snapshots > Configure. Select the volume name from the drop-down list, 
uncheck Scheduled, enter „0 for weekly, nightly, and hourly snapshots, and click 
Apply. 

 

This step can also be performed by using the CLI. To set the volume options for 
Snapshot copies to the recommended setting by using the CLI:  

a. Log in to the NetApp console. 

b. Set the volume Snapshot schedule: 

snap sched <vol-name> 0 0 0 

8. Set the volume fractional reserve value to 0. For detailed information about this 
setting, see NetApp TR 3505.  

vol options <vol-name> fractional_reserve 0 

3.6.2.2 Create a NetApp Flexible Volume for the LUN Configured as the Windows 
Failover Cluster Quorum Disk on Server Core Installation 

This procedure is required only if you plan to install Windows Server 2008 with the server 

core installation option. Otherwise, skip to section 3.6.2.3.  Repeat the procedure 

described in section 3.6.2.1 to create a 10GB flexible volume to host the LUN to be used 

as the quorum disk on server core installation. 

3.6.2.3 Create a NetApp Flexible Volume for the LUNs Configured to Host VMs 
Created by Using Hyper-V Manager on Windows Server 2008 Full 
Installation  

Repeat the procedure described in section 3.6.2.1  to create a 100GB flexible volume to 

host the LUN to be used for VMs created by using Hyper-V Manager on full installation.  

3.6.2.4 Create a NetApp Flexible Volume for the LUNs Configured to Host VMs 
Created by Using Hyper-V Manager on Windows Server 2008 Server Core 
Installation 

This procedure is required only if you plan to install Windows Server 2008 with the server 

core installation option. Otherwise, skip to section 3.6.2.5.  Repeat the procedure 

described in section 3.6.2.1 to create a 100GB flexible volume to host the LUN to be used 

for VMs created by using Hyper-V Manager on server core Installation. 

http://www.netapp.com/us/library/technical-reports/tr-3505.html
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3.6.2.5 Create a NetApp Flexible Volume for the LUNs Configured to Host VMs 
Created by Using SCVMM 2008 

Repeat the procedure described in section 3.6.2.1  to create a 100GB flexible volume to 

host the LUN to be used for VMs created by using SCVMM 2008.   

3.6.3 Configure iSCSI on Windows Server 2008 Server  

This procedure is required only if you plan to install Windows Server 2008 with the server core 

installation option. Otherwise, skip to section 3.7. 

Step Action 

1. The Windows Server 2008 server core installation needs to have the iSCSI services 
running to access the iSCSI target. Use the following command at the prompt to initiate 
the services during the boot and start the service: 

sc config msiscsi start= auto 

net start msiscsi 

 

2. After the services are started, add the target‟s (NetApp storage array) IP address. Use 
the following command to add the target portal: 

iscsicli QAddTargetPortal <Portal IP Address> 

where <Portal IP Address> is the IP of the NetApp storage controller.  
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3. After adding the Portal IP, use the following command to list the target IQNs: 

iscsicli ListTargets 

 

4. The IQN obtained from the previous command can be used to establish an iSCSI 
session.  

Use the following command to perform a login and establish a connection: 

iscsicli QloginTarget <target_iqn> 

where <target_iqn> is the IQN obtained in step 3 

The login operation returns a message indicating a successful session. 

3.6.4 Configure Windows Server 2008 Initiator Groups on NetApp Storage 

This procedure is required only for Windows Server 2008 servers with server core installation. 

Otherwise, skip to section 3.7. 

For Windows Server 2008 servers with the full installation option, NetApp SnapDrive software is 

used to perform this procedure. 
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Step Action 

1. Use the following command to obtain the initiator (Windows Server 2008 server) IQN 
from the command line on the Windows Server 2008 server: 

iscsicli 

 

2. Create initiator groups for all the Windows Server 2008 with server core installation on 
the NetApp storage by using FilerView: Filer View > LUN > Initiator Groups > Add. 

3. Enter the Initiator Group Name. Select iSCSI for the type, Windows for the operating 
system, and IQN for the initiator (Windows Server 2008 server core installation) obtained 
from the previous step. Click Add.  
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3.7 MICROSOFT WINDOWS FAILOVER CLUSTERING CONFIGURATION 

3.7.1 Windows Server 2008 Full Installation 

3.7.1.1 Installation Failover Clustering Feature 

For the detailed procedure, follow the guidelines outlined in the Microsoft documentation.  

Step Action 

1. Open Server Manager, click Features, and click Add Features. 

 

2. Check Failover Clustering and click Next. 

 

3. Click Install to continue. 

4. When installation is complete, click Close.  

 

http://technet.microsoft.com/en-us/library/cc732181.aspx
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3.7.1.2 Windows Failover Cluster Validation 

For the detailed procedure, follow the guidelines outlined in the Microsoft documentation.  

Step Action 

1. On the server, select Start > Programs> Administrative Tools > Failover Cluster 
Management. 

 

2. In the center pane, under management, click Validate a Configuration. 

 

http://technet.microsoft.com/en-us/library/cc732181.aspx


48    Hyper-V on NetApp Deployment Guide 

3. Follow the wizard to validate the cluster before creating it. 

 

4. A summary page appears at the end of the procedure. Click View Report and 
analyze the test results for success and warnings. 
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3.7.1.3 Create a Windows Failover Cluster 

For the detailed procedure, follow the guidelines outlined in the Microsoft documentation.  

Step Action 

1. In the Failover Cluster Management window, click Create a Cluster. Enter the 
names of the servers that will be part of the cluster and click Next. 

  

2. Enter a name and IP address for the cluster and click Next. 

 

http://technet.microsoft.com/en-us/library/cc732181.aspx
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3. On the Summary page, click View Report” to view a report of the task performed 
by the wizard. 

 

3.7.1.4 Configure Windows Failover Cluster Quorum 

The quorum disk is a disk on the shared storage that is designated to hold a copy of the 

failover cluster configuration database. 

CREATE A SHARED LUN BY USING NETAPP SNAPDRIVE 

Step Action 

1. Open Server Manager and select Storage > SnapDrive > Server Name > Disks. 

2. Right-click and select Create a Disk. 

3. In the Create Disk wizard, select a storage system name, LUN path, and LUN 
name. Use the NetApp volume created in section 3.6.2.1 to host the witness 
disk. 
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4. On the Select a LUN Type page, select Shared (Microsoft Cluster Services only) 
and click Next.  

 

5. The next page displays all the active nodes in the cluster. Click Next to continue. 
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6. Assign a drive letter and a size. Click Next to continue. 

 

7. Continue through the wizard. On the Select Initiators page, check the WWN or 
IQN (based on the requirements) for all the servers in the cluster. Click Next to 
continue. For this exercise, we will use Fibre Channel initiators.  
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8. On the Select Initiator Group Management page, select either Automatic or 
Manual. For this exercise, we will select Automatic. Click Next. 
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9. On the Specify Microsoft Cluster Services Group page, select Available Storage 
for the group name and click Next to continue. 

 

If Available Storage is not listed in the Group Name drop-down list, make sure 
that the Windows server that is creating the shared disk is the owner of the 
Available Storage cluster group. To find out the owner of the available storage, 
enter the following command at the command prompt.  

cluster group "Available Storage" 

  

If the group is owned by a different server, you can either use that server to 
create the shared disk or use the failover cluster command line to move the 
Available Storage group between different nodes. The Failover Cluster MMC 
snap-in does not provide this feature.  

cluster group "Available Storage" /MOVE 



55    Hyper-V on NetApp Deployment Guide 

10. Continue through the wizard and click Finish to start the LUN provisioning 
process. 

 

11. The Details section of the Disks MMC Snap-In for SnapDrive shows the steps 
as the disk is being configured. 

 

CONFIGURE WINDOWS FAILOVER CLUSTER QUORUM DISK 

Step Action 

1. To launch the Windows Server 2008 Failover Cluster Management snap-in: 
Start > Programs > Administrative Tools > Failover Cluster Management. 

2. Click the name of the failover cluster for which you want to configure the witness 
disk. 
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3. From the menu choices at the top of the snap-in, select Action > More Actions > 
Configure Cluster Quorum Settings to launch the Configure Cluster Quorum 
Wizard.  

 

4. In the Configure Cluster Quorum Wizard, click Next to display the Select 
Quorum Configuration page.  

5. On the Select Quorum Configuration page, select Node and Disk Majority and 
click Next to display the Configure Storage Witness page.  
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6. On the Configure Storage Witness page, select the shared LUN that you 
created in SnapDrive to be the witness disk and click Next. The Confirmation 
page is displayed. 

 

7. In the Confirmation page, click Next to configure the cluster quorum settings. 

When the quorum settings are configured, the Summary page is displayed. 

8. On the Summary page, click Finish to close the wizard. 

 

3.7.2 Windows Server 2008 Server Core Installation 

This step is required only if you plan to install Windows Server 2008 with the server core installation 
option. Otherwise, skip to section 3.8. 

3.7.2.1 Install the Failover Clustering Feature  

RDP to the Windows Server 2008 server core installation and run the following command 

to enable Windows failover clustering. Reboot the server when prompted.
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Steps Action 

1. Enter the following command on both of the servers: 

ocsetup FailoverCluster-Core 

 

3.7.2.2 Validate the Windows Failover Clustering Configuration  

To verify the success of the installation, run the following command and verify that the 

Failover Cluster feature is installed. 

Step Action 

1. Enter the following command on both of the servers: 

oclist 

 

3.7.2.3 Create a Windows Failover Cluster 

Create a Windows Failover Cluster for the server Core installation servers using the 

procedure outlined for the Windows Server 2008 full installation. To accomplish this 

procedure access the Failover Clustering MMC from one of the full installation servers. 

3.7.2.4 Configure Windows Failover Cluster Quorum 

The quorum disk is a disk on the shared storage that is designated to hold a copy of the 

failover cluster configuration database. 

CREATE A SHARED LUN 

To create a LUN using NetApp FilerView to be used as a Windows Failover cluster 

witness disk, follow these steps. 
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Step Action 

1. Log in to the NetApp console using an SSH, Telnet, or Console connection. 

2. Enter the following at the prompt: 

lun setup 

3. For Do you want to create a LUN? [y], enter the following at the prompt: 

Y 

4. Enter the LUN type. For Windows Server 2008 (including Hyper-V), enter  the 
following at the prompt: 

windows_2008 

5. Enter the LUN path. 

Example: /vol/<volume_name>/<lun_name> 

6. Select whether the LUN is to be space reserved. For this exercise, we will leave 
this value at the default, Yes.  

7 Enter the LUN size. For this exercise, we created a 2GB LUN for the quorum. 

8. Enter the comment string. 

9. Enter the name of the initiator group for the server, created in section 3.6.4.  

10. Select the LUN ID at which the initiator group sees the LUN. Leaving this blank 
autoselects the LUN ID. 

11. Accept the configuration by entering the following at the prompt: 

Y 

12. Map the initiator groups for additional Windows Server 2008 servers that will be 
part of the Windows Failover Cluster to this LUN: 

lun map [ -f ] <lun_path> <initiator_group> [<lun_id>] 

CONNECT THE WINDOWS SERVER 2008 SERVER CORE INSTALLATION SYSTEM 
TO LUNS PROVISIONED ON A NETAPP STORAGE SYSTEM  

To connect a previously created LUN, follow these steps.   

Step Action 

1. Open the Computer Management window from either the server with Windows 
Server 2008 full installation or any other Windows server and connect to one of 
the Windows Server 2008 servers with server core installation. 
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2. Open Disk Management: Storage >Disk Management. 

 

3. Rescan disks: Right-click Disk Management and select Rescan Disks. 

 
A rescan forces the rescanning of all HBAs (FC and iSCSI) to discover changes 
in the storage that is available to the Windows Server 2008 server. 
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4. When the LUN has been identified, bring it online and format with the NTFS file 
system. When initializing disks, use the default partition style, master boot 
record (MBR).  
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5. Connect to the other Windows Server 2008 nodes in the failover cluster, rescan 
disks, and bring the disk (shared LUN) online. 

 

CONFIGURE THE WINDOWS FAILOVER CLUSTER QUORUM DISK  

Step Action 

1. Open the Windows Failover Cluster Management snap-in by accessing the 
Failover Clustering MMC from one of the Windows Server 2008 servers with full 
installation. 

2. Expand the failover cluster for the server core installation servers for which you 
want to configure the witness disk. 
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3. Right click Storage and select Add a Disk. 

 

4. Select the disk created earlier and click OK. 

 

5. The remaining steps are the same as described in section 3.7.1.4. 
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3.8 DISK PROVISIONING ON WINDOWS SERVER 2008 SERVERS  

3.8.1 Windows Server 2008 Full Installation 

3.8.1.1 Create a Shared LUN by Using NetApp SnapDrive to host Production VMs 
Configured by Using Hyper-V Manager 

Follow the procedure described in section 3.7.1.4 to create a LUN to host the production 

VMs configured by using the Hyper-V Manager. Also make sure that the disk is removed 

from the Cluster Resource Group. 

3.8.1.2 Create a Shared LUN by Using NetApp SnapDrive to host VMs Configured Through 
SCVMM 

Repeat the process described in section 3.7.1.4 to create a LUN to host the production 

VMs configured through SCVMM. Also make sure that the disk is removed from the 

Cluster Resource Group. 

3.8.2 Windows Server 2008 Server Core Installation  

This procedure is required only if you plan to install with the Windows Server 2008 server core 

installation. Otherwise, skip to section 4. 

3.8.2.1 Create a Shared LUN 

Follow the procedure in section 3.7.2.4 to create a shared LUN to host the VMs configured 

through Hyper-V Manager. 

4 VIRTUAL MACHINE PROVISIONING  

4.1 PROVISIONING USING HYPER-V MANAGER 

This procedure is the same for both Windows Server 2008 full and server core installation options. For the 

detailed procedure, refer to the Microsoft documentation. 

Note: Use the Hyper-V Manager on Windows Server 2008 with full installation to access the Windows 

Server 2008 with server core installation. Open Hyper-V Manager, right-click Hyper-V Manager, select 

Connect to Server, select Another Computer, and enter the name of the Windows Server 2008 with server 

core installation. 

4.1.1 Create a Virtual Machine 

Step Action 

1. Open Hyper-V Manager: Start > Programs > Administrative Tools > 

Hyper-V Manager. 

2. From the Actions menu on the right, select New and then click Virtual Machine. 

http://technet.microsoft.com/en-us/library/cc732470.aspx
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3. In the New Virtual Machine Wizard window, enter the name of the VM. 

Specify the disk drive created in section 3.8.1 as the location to store the virtual machine 
configuration file. 

For backup and recovery purposes, it is best to store the virtual machine configuration file 
with the virtual machine virtual hard disks (VHDs). 

 

4. Specify the amount of memory for the VM and click Next. 
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5. Specify the Hyper-V virtual network to which to connect the virtual machine, if desired, 
and click Next.  

For this exercise, we will connect the VM to the external network VMEXT01_LAN. 
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6. On the Connect Virtual Hard Disk configuration page, specify the VM virtual hard disk 
(VHD) configuration.  

 Select “Attach a virtual hard disk later.” When creating a new VHD, by default 
Hyper-V Manager uses the dynamically expanding VHD type. NetApp best 
practice is to use the fixed-size VHD. For more information, see NetApp TR 
3702.  

 To use a golden image of a virtual machine by attaching the VM to an existing 
VHD, select “Use an existing virtual hard disk.” 

When specifying the location, only the virtual machine VHDs is placed in that location, not 
the virtual machine configuration file as well. To configure the location of the virtual 
machine configuration file to be the same as for VHDs, please make sure that the correct 
location is specified in step 3. For this exercise, we will select “Attach a virtual hard disk 
later” and click Next. 

 

http://www.netapp.com/us/library/technical-reports/tr-3702.html
http://www.netapp.com/us/library/technical-reports/tr-3702.html
http://www.netapp.com/us/library/technical-reports/tr-3702.html


68    Hyper-V on NetApp Deployment Guide 

7. Verify the configuration and click Finish. 

 

8. In Hyper-V Manager, select the newly created VM and click Settings in the right pane to 
open the Settings wizard.  
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9. In the Settings window, click IDE Controller 0, make sure that Hard Drive is selected, and 
click Add. 
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10. Click New to open the New Virtual Hard Disk Wizard.   

 

11. In the New Virtual Hard Disk Wizard, click Next. On the Choose Disk Type page, select 
Fixed Size. 

  



71    Hyper-V on NetApp Deployment Guide 

12. Specify the name and location where the fixed size VHD will be stored and click Next.  

For this exercise, we will select the location to be the same disk that was created using 
SnapDrive. 

 

13. Select the size of the new blank VHD and click Next.   
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14. Click Finish and then click OK to complete creation of the disk. 

 

4.1.2 Child VM Partition Alignment 

For fixed-size VHDs, NetApp strongly recommends aligning the file system of the VHD to the file 
system of the underlying physical disk for best performance as the system scales out. For more 
details on this recommendation, see NetApp TR 3702. 

Step Action 

1. Boot the newly created VM with the Windows Preinstall Environment boot CD. 

2. Enter Alt+M, select Run, type cmd to enter the command prompt, and enter the following 
at the prompt:  

diskpart 

3. Enter the following at the prompt:  

select disk 0 

Enter the following at the prompt:  

create partition primary align=32 

  

4. Shut down the child VM with the Windows Preinstall Environment boot CD. 

http://www.netapp.com/us/library/technical-reports/tr-3702.html
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4.1.3 Install Operating System 

Step Action 

1. To install the operating system, go back to the VM Settings window by using the steps 
described earlier. Click DVD Drive, select Image File, and specify a location for the ISO. 
Then click OK. 

 

2. In the Hyper-V Manager, click the newly created VM, right-click, and select Connect.  
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3. Click the green Start button. 

 

4. Install the operating system as you would install the OS on a physical system. 

Note: You will not be able to use your mouse throughout the installation because the 

Hyper-V Integrated Services component of Hyper-V is not yet installed on the VM. 

4.1.4 Install Hyper-V Integrated Services 

Step Action 

1. Log in to the newly created VM. 

2. Select Action > Insert Integration Services Setup Disk to install the Hyper-V Integration 
Services. If the installation does not begin immediately, navigate to the CD drive and run 
the setup from there. 
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3. Reboot the VM to complete installation. 

4. Once the Hyper-V Integrated Services is installed, you can use your mouse in the 
environment. 

4.2 PROVISIONING BY USING SCVMM 2008  

4.2.1 Create a Virtual Machine 

Step Action 

1. Open Virtual Machine Manager Administration Console: Start > Programs > Microsoft 
System Center > Virtual Machine Manager > Virtual Machine Manager Administration 
Console. 

2. Select a host group. 

In the right pane, select New Virtual Machine to begin creating a new VM. 

 

3. Select “Create the new virtual machine with a blank virtual hard disk.” 
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4. Specify the virtual machine name and the owner of the VM. Add a description of the VM 
and any notes and then click Next. 
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5. To configure VM hardware, select to use a new or existing hardware profile. To create 
this VM, we will use a new hardware profile. 

 Configure the processor and memory for the VM. 
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6. Specify the Virtual Hard Disk configuration for the Virtual Machine. 

 To use a golden image of a virtual machine by attaching the VM to an existing 
VHD, select “Use an existing virtual hard disk.” 
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7. Specify the virtual CD/DVD drive configuration for the virtual machine:  

 Select “Existing image file” to browse for an existing ISO image. 

 Select “Physical CD/DVD drive” to use the Windows Server 2008 server‟s 
physical CD/DVD-ROM drive. 

 



80    Hyper-V on NetApp Deployment Guide 

8. Configure the network adapter for the virtual machine. 

Note: In step 13 you will specify the Hyper-V virtual network to which to connect each 

configured network adapter for the VM.   
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9. Select the priority of the virtual machine based on CPU resources relative to other VMs 
residing on the same Windows Server 2008 server. 

 

Note: You must have a Hyper-V cluster configured in SCVMM in order to make the 

virtual machine highly available. 
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10. Select “Place the virtual machine on a host” to continue creating the virtual machine. 
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11. Select the Windows Server 2008 host on which to place the newly created virtual 
machine. If the server is a clustered host (part of the failover cluster), you are prompted 
to make the VM highly available. 
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12. Specify the path/location for storing the virtual machine configuration file and VHDs. 
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13. Specify the virtual network on the Hyper-V host to which each configured network 
adapter for the VM should be connected.  
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14. Specify the operating system to be installed in the VM. 

 

15. Click Create to complete the creation of the new virtual machine. 
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4.2.2 Child VM Partition Alignment 

For fixed-size VHDs, NetApp strongly recommends aligning the file system of the VHD to the file 

system of the underlying physical disks for best performance as the system scales out. To align the 

child VM partition, follow the procedure described in section 4.1.2.  

4.2.3 Install Operating System 

To connect to the VM directly from SCVMM, follow this step.  

Step Action 

1. To connect to the VM directly from SCVMM, select the VM, right-click, and select 
Connect to Virtual Machine. 

 

 

5 QUICK MIGRATION SETUP AND CONFIGURATION 

5.1 ENABLE HIGH AVAILABILITY FOR A VIRTUAL MACHINE 

5.1.1 VMs Provisioned by Using Hyper-V Manager (for Both Full and Server Core 
Installations) 

Now that we have created the VMs, the next step is to configure them for high availability by 

creating a VM resource group. 
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Step Action 

1. Open the Failover Cluster Manager. 

2. Right-click Services and Applications in the left pane and select Configure a Service or 
Application. 

.  

3. Skip the introduction page and click Next. 

4. Select Virtual Machine as the service or application type. 
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5. Select the virtual machine to make highly available.  

 

6. Review the summary and click Next to continue the creation of the virtual machine 
resource group. 

7. Click Finish to complete the creation of the Virtual Machine resource group. 
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8. To review the details of the virtual machine resource group, select it under Services and 
Applications in the left pane. 

 

9. Select Show Dependency Report to review the dependencies of each resource in the 
virtual machine resource group. 
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10. Under Storage in the left pane, note the creation of the Virtual Machine cluster resource 
group for the disk where the VM is stored. The cluster places a reservation on this disk 
and the disk is removed from Available Storage. 

 

11. Creating the virtual machine resource group caused the VM to be powered off. To power 
on the virtual machine by using Failover Cluster Manager, select “Bring this service or 
application online” in the right pane or right-click the virtual machine resource and select 
“Bring this resource online.” 
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5.1.2 VMs Provisioned by Using SCVMM  

If the Windows Server 2008 server is not part of the Windows Failover Cluster, follow these steps 
to configure the VM to be highly available.  

Step Action 

1. Select the virtual machine. From the right pane select Properties; or right-click the virtual 
machine and select Properties. 

 



93    Hyper-V on NetApp Deployment Guide 

2. On the Hardware Configuration tab, select Advanced > Availability.  Select “Make this VM 
highly available” and click OK to apply the changes to the virtual machine configuration. 

 

 

This is what a configuration looks like for a highly available virtual machine. 
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6 NETAPP DEDUPLICATION ON PRIMARY STORAGE 

With NetApp deduplication, Hyper-V deployments can eliminate the duplicate data in their environments, 

enabling greater storage utilization. Deduplication is enabled on the NetApp volume, and the amount of data 

deduplication realized is based on the commonality of the data stored in a deduplication-enabled volume. 

When you have created multiple VMs on the NetApp volume, follow these steps to deduplicate data on the 

volume.  

Step Action 

1. Connect to the NetApp controller‟s system consol by using SSH, telnet, or serial 
console. 

2. Enter the following command to enable deduplication for the gold volume:  

sis on <volume path>  

3. Enter the following command to start processing existing data:  

sis start –s <volume path>  

4. Enter the following command to monitor the status of the deduplication operation: 

sis status 

5. When the deduplication has finished, enter the following command to see the savings: 

df –s 

6. To schedule deduplication to run at regular intervals, use the following command: 

sis config -s  <schedule> <volume_path> 

Where <schedule> can be in the following format: 

schedule is [day_list][@hour_list] or [hour_list][@day_list] or - or auto 

The day_list specifies which days of the week SIS operations should run. It is a comma-
separated list of the first three letters of the day: sun, mon, tue, wed, thu, fri, sat. The 
names are not case sensitive. Day ranges such as mon-fri can also be given. The 
default day_list is sun-sat. 

The hour_list specifies which hours of the day SIS operations should run on each 
scheduled day. The hour_list is a comma-separated list of the integers from 0 to 23. 
Hour ranges such as 8-17 are allowed. Step values can be used in conjunction with 
ranges. 

For example, 0-23/2 means "every two hours." The default hour_list is 0; that is, 
midnight on the morning of each scheduled day. 

7 QUICK MIGRATION 

Use quick migration to quickly move the VMs between Windows Server 2008 Hyper-V servers, supported on 

both full and server core installations.  

The Hyper-V Manager provides information about the host server.  
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Step Action 

1. Open the Failover Cluster Management console to view the virtual machines running on the 
individual Windows Server 2008 nodes. 

2. Right-click the virtual machine name to open the Actions menu. You have the option to move 
the virtual machine to another node, and you can select the destination node.  

 

3. When the command has been run, the virtual machine enters a pending state before it is 
moved.  
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4. After a few seconds, the virtual machine appears on the destination node and the status 
returns to Online.  

 

8 TESTING AND VALIDATION OF THE HYPER-V AND NETAPP 
ENVIRONMENT  

Here is a checklist to help you determine that the environment is working correctly. Run these tests as 

appropriate for your environment and document the results. 

Item Description Completed (Y/N) 

1. Test Ethernet connectivity for Windows Server 2008 servers 
and NetApp. If using NIC teams or VIFs, pull network cables 
or down the interfaces and verify network functionality. 

 

2. If running in a cluster, test SAN multipathing by pulling the 
cable or by disabling a switch port (if applicable). 

 

3. Test SCVMM functionality for appropriate access control, 
authentication, and communication with Windows Server 
2008 servers 

 

4. Perform NetApp cluster failover testing and verify that 
physical disks remain connected. 
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ABOUT MICROSOFT VIRTUALIZATION SOLUTIONS 

Microsoft provides a complete suite of technologies to enable an integrated, end-to-end, virtualized 

infrastructure. Using products that span the desktop to the data center, Microsoft technologies bring 

capacities online in real time, as needed; streamline and provision applications, services, and data on 

demand; accelerate backup and recovery; and enhance availability to protect against system failure and 

service interruptions. Microsoft's extensive partner ecosystem complements and extends the Microsoft 

virtualization toolset with products for desktops, servers, applications, storage, and networks. Together with 

our partners, we deliver the most robust, complete solutions for the virtualized infrastructure. For more 

information about Microsoft Joint Virtualization Solutions, visit 

http://www.microsoft.com/virtualization/partners.mspx. 
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